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Navigating WinRampTM Lite
 

Toolbar Buttons
Menus



Toolbar Buttons
 

Every commonly used function and command within WinRamp Lite is bound to a graphical button. For 
easy access, these buttons are grouped together in a user-customizable Toolbar that can be "anchored" 
to any four sides of the screen or made to float wherever it may be convenient. Below is a complete list of
toolbar buttons available within WinRamp Lite. 

General Application Functions & Commands

Exit WinRamp Lite

Copy to Clipboard

Paste from Clipboard

Open Terminal

Manual Dial

Hot Dial Window

Open Dialing Directory

Default Terminal Window Size

Cascade Windows

Tile Vertically

Tile Horizontally

Arrange Icons

Online Help

Online Action Functions & Commands

Mark Graphics

Mark Text

Download/Receive File

Upload/Send File



Hangup Modem

Reset Modem

Reset Terminal

Start Capture

Scroll Back

Save Scrollback Buffer

Doorway Mode

Record Macro

Playback Macro

Configuration Functions & Commands

Device Configuration

Terminal Configuration

Protocol Configuration

Global Preferences

Toolbar Editor

Fine Tune Current Device

Toggle Full/Half Duplex

Send Break

Toggle Automatic Answering

Dialing Directory Functions & Commands

Dial Dialing Directory

Edit Dialing Directory Entry

Add Dialing Directory Entry



Delete Dialing Directory Entry

New Dialing Directory

Delete Dialing Directory

Directory Tabs

Quick Select Tab



What is WinRampTM Lite?
 

WinRamp Lite is a communications package that operates in the Microsoft Windows environment and is 
developed by Vironix N.A. Inc.    WinRamp Lite allows you to use a modem to communicate with millions 
of other computers via the telephone system. You can communicate and exchange files with other 
computers either directly, or via one of the many available Bulletin Board Systems.    As a Shareware "Try 
Before You Buy" product, WinRamp Lite brings true value for money to the Windows communications 
desktop. Below are some of the features of WinRamp Lite:

1. WinRamp Lite provides RipScrip Terminal Emulation based on the complete RIP 1.54 Specification.
2. With WinRamp Lite it is possible to view multiple windows of the same incoming data-stream in 
multiple terminal emulations.
3. The Dialing Directory in WinRamp Lite allows searching and can dial a list of multiple numbers until it 
gets a connection in one of them.
4.    You can also create multiple Dialing Directories in WinRamp Lite so that you can classify, store and 
access numbers with ease.
5. The WinRamp Lite Toolbar, complete with "Tooltips", is customizable and can be set to float or can be 
anchored to the left, right or bottom edges of the screen.
6. WinRamp Lite allows copying of graphics onto the clipboard.
7. WinRamp Lite's Hot Dial feature provides easy access to your favourite BBS's by making dialing to it 
as easy as double clicking.



Menus
 

File Menu
Edit Menu
Communicate Menu
Configure Menu
Dialing Directory Menu
Window Menu



File Menu
 

Download
Upload
Start Capture
Save Scrollback
Text Editor
Record Macro 
Playback Macro 
Exit
Exit & Hangup



Edit Menu
 

Mark Graphics
Mark Text
Copy
Paste
Scroll Back



Configure Menu
 

Device
Terminal
Protocol
Preferences
Toolbars
Current Terminal
Fine Tune



Communicate Menu
 

Open Terminal
Manual Dial
Dialing Directory
Hotdial Window
Hangup
Send Break
Full Duplex
Reset Modem
Auto Answer
Doorway Mode
Reset Terminal



Dialing Directory Menu
 

Dial
Edit
Add
Delete
New Directory
Delete Directory
Directory Tabs
Quick Select Tabs
Toolbar



Window Menu
 

Tile
Cascade
Arrange Icons
Default Size



Contacting Vironix NA
 

US Mail, Email, Phone, Fax, BBS, Internet 

Use any of the following addresses/contact details to contact Vironix NA: 

U.S. Mail

Vironix NA
P.O. Box 1570
Haverhill
MA, 01831-9998
USA

Telephone

1-508-373-2402

Fax

1-508-374-7125

Electronic Mail

Compuserve:  74757,207    and    100075,255
America Online: Vironix
Internet Addresses:

Mailing List:    winramp@vironix.co.za **
Join Mailing List:    winramp-request@vironix.co.za
Information: info@vironix.co.za
Bug Report: bugrep@vironix.co.za
Comments: comments@vironix.co.za 

** NB! After August 1994, change all <name>@vironix.co.za to <name>@vironix.com

WinRamp Support BBS

1-508-373-3336    (4 lines @ V.32bis or lower)

NB! Please note. The WinRamp Support BBS is currently going through daily development changes, 
thus during the months of July and August 1994 we will not be actively maintaining the BBS data itself. 
However please feel free to open an account on the BBS and take a basic look around. The system has 
been custom developed on the SCO UNIX platform specifically so that we can provide seamless and full 
Internet access as soon as possible. Your WinRamp Lite registration is currently NOT required to access 
the BBS ... access is FREE and will remain free as long as it is financially feasible). During these next two
months we will be putting together a BBS that you will find both enjoyable to use and informative.

Accessing the WinRamp Support BBS via the Internet - Available September 1994

During early August 1994 we will be upgrading the WinRamp Support BBS to have full 56kb leased-line 
Internet access. You will be able to TELNET to the system, download WinRamp Lite upgrades and patch 
files via anonymous ftp. 

Although the following addresses may be subject to change without notice, we're currently 95% certain 



that the following Internet addresses will apply after August 1994: 

Anonymous FTP and TELNET: timba.vironix.com





Upload
Once a terminal emulation window is open, select this option to upload a file.



Download
Choose this option to download a file once a terminal emulation window is open.



Exit
Exits WinRamp Lite without disconnecting the connection to the host.



Exit & Hangup
Exits WinRamp Lite and disconnects the modem connection to the host.



Mark Graphics
Allows the selection of graphics, pixel by pixel, in the emulation window so that they can be copied to your
clipboard in bitmap format.    If you select text instead of graphics, the text will be cut as a bitmap.



Mark Text
Allows the selection of any text, character by charatcer, so that it can be copied to the clipboard.    
Selecting graphics in this mode will have no effect.



Copy
Copies any selected text or graphics to the clipboard.



Paste
Pastes any text in the clipboard to the location specified.



Dial
Select this option to specify the communication device you want to use, the type of terminal you would 
like to emulate and the number you want to dial.



Dialing Directory
Allows you to open the Dialing Directory window which will contain any dialing directories you may have 
set up and will allow you to add any new directories or entries you may like.



Device
Configure device allows you to specify the settings for your modem.



Terminal
Enables the customisation of the base Terminal emulations by modifying the settings in the Terminal 
Configuration.



Fine Tune
Allows the modification of the settings, e.g. the line speed, of the device that is in use in your present 
communication session.



Current Terminal
Allows the modification of the settings of the terminal emulation you are currently using in your 
communication session.



Doorway Mode
Enables a mode in which none of the keystrokes you may have specified are sent i.e. mapped keys will 
have their normal functions provided the host supports Doorway Mode too.



Preferences
Allows the setting of the global preferences of WinRamp Lite.



Toolbars Menu

Edit: Starts up the Toolbar editor which allows you to customise the toolbar.
Standard: Displays or hides the Standard functions toolbar.
Configuration: Displays or hides the Configuration functions toolbar.



Tile Horizontally
Tiles any open windows in a horizontal manner.



Cascade
Cascades any open windows.



Arrange Icons
Arranges any minimized windows in an orderly manner.



Default Size
Resizes the current window to the default size.



Scroll Back
Allows you to scroll back to previous screens by placing a scroll bar on the right of the window.    A tick 
mark appears next to this menu option when scroll back is activated.    The scroll back can be turned off 
when you are ready to resume your communication session.



Protocol
Allows the specification of    the settings for the ASCII, XModem, YModem, ZModem and Kermit protocols.



Hangup
Sends a hangup string to the modem.



Reset Modem
Sends a reset string to the modem.



Start Capture
Starts recording the session so that it can be viewed offline at a later stage.



Hot Dial
Brings up the Hot Dial window where all the icons for the numbers you have specified as being hot dial 
numbers are stored.



Help
Starts up the Online Help.



Main Functions
Displays the Main Functions toolbar below the drop-down menus.    This toolbar has buttons for file 
transferring, dialing, window arranging, exiting etc.



Edit Functions
Displays the Edit Functions toolbar below the drop-down menus.    This toolbar has buttons for 
configuration, marking, copying and pasting,capturing scroll back and editing the toolbar.



Dialing Directory Dial
Allows you to dial from a dialing directory entry or entries.



Edit Dialing Directory Entry
The settings for a dialing directory entry can be specified/modified by choosing this option.



Add a Dialing Directory Entry
A new dialing directory can be created and the settings specified for it.



Delete a Dialing Directory Entry
The selected entry can be deleted together with all its associated settings.



New Directory
An entirely new dialing directory can be created to store a list of dialing directory entries.



Delete Directory
Allows you to delete an entire dialing directory with all the entries and settings associated with them.



Directory Tabs
Enables or disables the Directory Tabs that appear at the bottom of the dialing directory window.



Quick Select Tabs
The alphabetical Quick Select Tabs on the right side of the dialing directory window can be enabled or 
disabled.



Save Scrollback
Enabling this option has the effect of saving anything in the scroll back buffer to the capture file in the path
that is specified in the Directory section of the Preferences option.



Text Editor
Launches the Text Editor that has been configured in the Preferences option.



Open Terminal
This option is used for a manual connection i.e. it enables you to send commands directly to your modem.
You can select the terminal emulation you would like from the dialog box that will come up.



Send Break
Sends a special line break condition across the modem.



Full/Half Duplex
This mode enables a bi-directional transfer of information i.e. you can type characters as other characters
come in as opposed to having to wait until you have received all the characters from the host. Half Duplex
Mode enables the transfer of information in one direction at a time.    This usually implies that your own 
machine will echo your typing.



Auto Answer
Turns the Auto Answer mode on your modem on so that it will automatically answer the phone if it rings.



Reset Terminal
Refreshes the terminal screen and sends the cursor to the top.    This is useful if line noise has interfered 
with your terminal display.



Dialing Directory Toolbar
Displays or hides the Dialing Directory toolbar at the bottom of your screen.    All the actions that can be 
performed on the dialing directory are available on this toolbar.



Tile Vertically
Tiles any open windows in a vertical manner.



Edit Toolbar
Starts up the Toolbar editor which allows you to customise the toolbar.



 Record Macro
A macro is a sequence of key presses that can be saved as a <filename>.mac file.    The Record Macro 
option allows you to literally record every action you perform using your keyboard during an open 
communication session.    This    sequence of actions can then be executed whenever necessary.



Playback Macro
Executes a macro that you have recorded.    When the macro is executed the recorded sequence of key 
presses are automatically performed at the speed they were recorded or faster if you so specify.
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PRESTEL Terminal
Preferences, Editing
Protocol, Add 
Protocol, Default Settings 
Protocol, Duplicate 
Protocol, Edit Settings 
Protocol, Remove 
Protocol, Set Default 

Q

R

Record a Session 
Remove a Device 
Remove a Protocol 
Remove a Terminal 
RIPScrip 1.54

S

Scroll Back 
Settings 
Settings, Device 
Settings, Protocol 
Settings, Terminal 

T

Terminal, Add 
Terminal, Default Settings 
Terminal, Duplicate
Terminal, Edit Settings
Terminal, Remove 
Terminal, Set Default 
Text, Copy & Paste 
Toolbar, Customizing
Toolbars 
Troubleshooting

U

Upload a File 

V

Vendor, Modem Defaults 
Viewing Multiple Terminal Emulations 

W



Window Menu 
WinRamp Lite 

X

Y

Z

ZModem Protocol



Index
The Main Index can be used to quickly search alphabetcically for topics





HOW TO.....

 

Get Started
Establish a Connection
Configure a Dialing Directory
Define a Device
Configure a Terminal
Configure a Protocol
Manual Dial
Hot Dial
Open a Terminal
Upload a File
Download a File
Scroll Back
Map a Key
Customise the Toolbar
Set Preferences
Copy and Paste Text
Copy and Paste Graphics
Fine Tune Current Device
Configure Current Terminal
Configure Doorway Mode
View Multiple Terminal Emulations
Record Your Session
Record a Macro
Playback a Macro



How To ... 
Get Started

Before you get WinRamp Lite to establish a connection it is necessary to define the device that you will 
be using for the connection.    A device is usually a modem or some kind of equipment that connects two 
computers in the same fashion as a modem.    In order for WinRamp to automate as much of the 
connection to the remote computer as possible, it is necessary to tell it what kind of device/modem is 
attached to your computer.    Defining a device involves specifying the line parameters the computer must 
use to send data to the modem, and the command which the modem uses to set it up for operation.    We 
strongly recommend the use of a Hayes-compatible modem.

When you dial the host computer, you have to select a terminal emulation for the communication session. 
A terminal emulation is a mode in which your computer will pretend to be a special piece of    hardware 
called a terminal.    Different terminals have different features e.g. some show only capital letters, others 
have text displayed in colour, still others show you graphics and allow you to click on buttons with your 
mouse.

Once you have defined your device and know what terminal emulation your host supports, you can 
proceed to establish a connection..



How To ... 
Configure Doorway Mode

Doorway Mode uses Keyboard scan codes instead of ASCII codes.    Normally, the keyboard scan codes 
e.g. cursor movements, the alt key and function keys are interpreted as commands in the emulation 
window.    In doorway mode, these keys will have their normal functions provided the host also has 
doorway mode support.    This enables the running of programs on the host by remote control.

This function is only enabled once a Terminal Emulation window is opened.
- Establish a connection with your intended host.
- Select Doorway Mode from the Communicate menu or click the Doorway Mode button.
- Deselect the Doorway Mode option from the Communicate menu if you want to disable Doorway Mode.



How To ... 
Configure Current Terminal

This function is only enabled once a Terminal Emulation window is opened.
- Select Configure Current Terminal from the Configure menu.
- You are presented with the dialog box of your current terminal emulation settings.
- Proceed to edit the Terminal Settings where necessary.



How To ... 
Fine Tune

This function fine tunes the current device and is enabled only once you have a Terminal Emulation 
window open.
- Select Fine Tune from the Configure menu or click the Fine Tune button from the Configuration Toolbar..
- You are presented with the dialog box of your current device/modem settings.
- Proceed to edit the Device Settings, e.g. line speed, where necessary.



How To ... 
Copy and Paste Graphics

- Select Mark Graphics from the Edit menu or click the Mark Graphics button once you have a Terminal 
emulation window open.
- Mark the Graphics with your mouse pointer by dragging it to draw a dotted square around the desired 
section.
- Select Copy from the Edit menu or click the Copy button.
- Go to the location you would like to Paste to.
- Select Paste from the Edit menu or click the Paste button.
- You can paste the graphics into a graphics package like Paintbrush so that you can use them once you 
are offline.
- If you mark text in this mode, it would be cut as graphics, i.e. in bitmap format and you would not be 
able to paste it.



How To ... 
Copy and Paste Text

The Copy and Paste function uses the standard Windows Clipboard and, therefore, allows you to Paste 
into any application that also supports the Windows Clipboard i.e. most Windows applications.

Note: The RipScrip Terminal emulation does not support Copy and Paste in Text mode.    Any text that is 
on the screen can be cut as a graphic but cannot be pasted back into the emulation window.

Manual Marking:
- Select Mark Text from the Edit menu or click the Mark Text button once you have a Terminal emulation 
window open.
- Mark the text with your mouse pointer.    If you click the left mouse button once, the character you are 
pointing to is marked, if you click it twice the entire word is marked.
- Select Copy from the Edit menu or click the Copy button.
- Go to the location where you would like to Paste.
- Select Paste from the Edit menu or click the Paste button.
- You can paste the text into an editor like Notepad so that you can use it once you are offline.

Fast Mark:
- Make sure that the Text radio button in your Terminal Emulation Setup is selected.
- To mark a character in your emulation window, point to it with your mouse and click the left button once.
- To mark a word in your emulation window, point to it with your mouse and click the left button twice.
- Click the right button of your mouse to send the text you have marked to your keyboard, i.e. the text will 
be pasted where your cursor is in the emulation window.
- This feature is particularly useful for selecting menu options requires using the keyboard.



How To ... 
Set Preferences

- Select Preferences from the Configure menu or click the Edit WinRamp Lite Preferences button.
- Modify the settings as you desire.
- Settings



How To ... 
Customise the Toolbar

- Select Toolbars from the Configure menu and select Edit from the secondary menu that will come up, 
OR
- Click the Edit, Add, Remove Toolbars button from the Configuration toolbar.
- You can either add tools/remove tools from the Standard or Configuration toolbars or create a toolbar of 
your own.

Creating a New Toolbar:
- Click the New button at the top pf the Toolbar Editor dialog box.
- Enter the name of your new toolbar in the Toolbar Name field.
- Press Enter.

Rename a Toolbar:
- Select the toolbar you would like to rename from the Toolbar name list at the top of the Toolbar Editor 
window.
- Modify the name in the Toolbar Name field.
- Press Enter.
- Click the OK button.

Delete a Toolbar:
- Select the toolbar you would like to delete from the Toolbar name list at the top of the Toolbar Editor 
window.
- Click the Delete button.
- Click the OK button.

Adding/Moving Tools:
- Select the toolbar you would like to modify from the Toolbar name list at the top of the Toolbar Editor 
window.
- The tools that are currently on that toolbar are displayed in the Toolbar Buttons list on the left.
- Select any additional tools from the Available Actions list by clicking on the tool.    An explanation of the 
action is presented to you at the bottom of the dialog box.
- Click the Arrow button between the two lists of buttons to add the selected tool to the toolbar OR drag 
the tool with your mouse and drop it in the Toolbar Buttons list on the left.
- Change the position of the tool in the list by clicking on the Up and Down buttons at the bottom of the 
Toolbar Buttons list or simply select and drag the tool to the position you like.
- Separators can be added to the Toolbar Buttons list from the Available Actions so that you have spaces 
between groups of tools.
- Change the position of the tool in the list by clicking on the Up and Down buttons at the bottom of the 
Toolbar Buttons list.
- Click the OK button when you are finished.

Removing Tools:
- Select the toolbar you would like to modify from the Toolbar name list at the top of the Toolbar Editor 



window.
- The tools that are currently on that toolbar are displayed in the Toolbar Buttons list on the left.
- Select the tool you would like to remove by clicking on it in the Toolbar Buttons list.
- Click the Remove button at the bottom of the Toolbar Buttons list to remove the tool.
- Click the OK button when you are done.



How To ... 
Map a Key

Keyboards for various terminals differ not only from each other but also from PC keyboards.    In order to 
accommodate these differences, you can map your keyboard to behave like the keyboard of another 
terminal or a PC.    You can also make a certain key a keystroke i.e. every time that key is pressed a set 
of events that you have specified will take place.    You can remap any key on the PC keyboard except the
Print Screen key.    You can also differentiate between normal, shift, alt, control, shift + alt, shift + control, 
alt + control and shift + alt + control characters.    The keymapping dialog box is very intuitive to use as it 
simulates the keyboard exactly.    Even the Num Lock, Caps Lock and Scroll Lock indicators light up.    You
can view characters as IBM, Control or Hexadecimal characters.

- Select the Terminal option from the Configure menu or click the Terminal Configuration button.
- Select the view you would like: IBM, Hexadecimal or Control.
- Select the key you want to map by pressing it or clicking the key on the Key Mapping dialog box with 
your mouse.
- Select the radio button for the Character set you would like to view the character with.
- Enter the keystroke you want the character to send in the bottom field.
- Click the OK button.
- Click the Exit button or select Exit from the File menu in the Key Mapping dialog box.
- Click the OK button in the Terminal Settings dialog box.



How To ... 
Configure a Dialing Directory

A Dialing directory is a kind of address book that conveniently stores the numbers you need to dial.    In 
addition to storing the number, a Dialing directory allows you to automatically dial the number you have 
chosen.    Configuring the Dialing Directory is like writing all the addresses you need into your address 
book.    By configuring the Dialing Directory you also store the settings such as the protocol, terminal 
emulations, login name and password for that number.    So, when you choose to dial a number, all the 
settings that go with it automatically take effect.

Create a New Dialing Directory
Add a Dialing Directory Entry
Edit a Dialing Directory Entry
Delete a Dialing Directory Entry
Delete a Dialing Directory
Navigate a Dialing Directory
Dial from the Dialing Directory



How To ... 
Dial from the Dialing Directory

- Select Dialing Directory from the Communicate menu or click the Dialing Directory button.
- Select the entry that you want to dial.
- If you cannot find your entry it may be because you have not enabled the Directory Tabs or the Quick 
Select Tabs.
- Once you have the correct entry selected, you can either double-click on it or click the Dial Entry/Entries
button to start the dialing process.



How To ... 
Navigate a Dialing Directory

The Directory Tabs and the Quick Select Tabs are provided for intuitive navigation of the Dialing Directory.
The Directory Tabs are used for your own classification and groupings of numbers while the Quick Select 
Tabs are alphabetic tabs for a Dialing Directory.    To find a particular entry, you have to select the 
appropriate directory first and then choose the tab with the letter the entry begins with.    If there are no 
entries beginning with a particular letter, no tab will appear for that letter making navigation that much 
easier.

- Select the Directory Tabs option from the Dialing Directory menu or click the Directory Tabs button on 
the Dialing Directory toolbar.
- A tick appears next to the option.
- Select Quick Select Tabs from the Dialing Directory menu or click the Quick Select Tabs button on the 
Dialing Directory Toolbar.
- A tick appears next to the option.
- You can select the dialing directory you want to look at by selecting its directory tab which appears at 
the bottom of the Dialing Directory window.
- The tab you select appears light grey and the tabs not selected appear dark grey.
- You can find dialing directory entries by clicking the tab letter that the name of the entry begins with.
- The Dialing Directory Entry Fields (i.e. Name, Terminal, Device, Protocol and Connects) have flexible 
sizes.    Use the following procedure to change the size:
- Move your mouse cursor to the vertical bar separating these fields.
- The cursor will change to a bar with arrows pointing in either direction.
- Drag the bar until the field is the size you would like it to be.



How To ... 
Delete a Dialing Directory

- Select Dialing Directory from the Communicate menu or click the Dialing Directory button.
- Select the Directory tab for the one you want to delete.
- If you cannot see the tabs, select Directory Tabs from the Dialing Directory menu.
- Select Delete Directory from the Dialing Directory menu or click the Delete Directory button on the 
Dialing Directory toolbar.
- You are presented with a Message dialog asking you to confirm the deletion - click the Yes button.



How To ... 
Delete a Dialing Directory Entry

- Select Dialing Directory from the Communicate menu or click the Dialing Directory button.
- Select the dialing directory entry you want to delete.
- Select Delete from the Dialing Directory menu or press the Del key or click the Delete Entry button on 
the Dialing Directory toolbar.
- You are presented with a Message dialog asking you to confirm the deletion - click the Yes button.



How To ... 
Edit a Dialing Directory Entry

- Select Dialing Directory from the Communicate menu or click the Dialing Directory button.
- Select the dialing directory entry you would like to edit.
- Select Edit from the Dialing Directory menu or press the Space Bar or click the Edit Entry button on the 
Dialing Directory Toolbar.
- Edit the necessary settings.
- Dialing Directory Settings
- Click the OK button when you are done.



How To ... 
Change the Dialing Directory Icon

- Select Dialing Directory from the Communicate menu or click the Dialing Directory button.
- Select the dialing directory entry for which you want to change the icon.
- Select Edit from the Dialing Directory menu or press the Space Bar or click the Edit Entry button on the 
Dialing Directory toolbar.
- Click the Advanced button on the upper right side of the dialog box.
- The current icon is displayed at the right side in the middle of the dialog box.
- Click the Change button next to the icon.
- Scroll across to find the icon you would like.
- If you want an icon in another directory, click the Browse button.
- Select the appropriate file in the appropriate directory.
- Click the OK button in the Select Icon File dialog box.
- Click the OK button in the Change Icon dialog box.
- Click the OK button in the Directory Entry Details dialog box when you are done.



How To ... 
Add a Dialing Directory Entry

- Select Add from the Dialing Directory menu or click the Add button on the Dialing Directory toolbar.
- You are presented with the Entry Details Dialog box.
- Type the Name of your entry.
- Type the number to dial in the Numbers field.
- Click the OK button in the New Number dialog box.
- Repeat the previous two steps to put in as many numbers as you like.
- Type in your BBS Login name and Password.
- Select the default Terminal Emulation from the drop-down box.
- Select the default Device from the drop-down box.
- Select the default File Transfer Protocol from the drop-down box.
- The connect information at the bottom of the dialog box will be updated each time you connect to that 
host until you Reset it.
- Click the Advanced button on the upper right side of the dialog box to configure the advanced settings.
- Change any advanced settings you would like e.g. download/upload directory, icon etc.
- Dialing Directory Settings



How To ... 
Create a New Dialing Directory

- Select the Dialing Directory option from the Communicate menu or click the Dialing Directory button.
- Select New Directory from the Dialing Directory menu or click the New Directory button on the Dialing 
Directory toolbar.
- Type the Name of your new dialing directory in the New Directory dialog box.
- Click the OK button or press Return.
- Your new Dialing Directory will appear as a tab in the Dialing Directory window.
- If you cannot see the directory tabs, select Directory Tabs from the Dialing Directory menu or click the 
Directory Tabs button on the Dialing Directory toolbar.



How To ... 
Scroll Back

Due to today's fast baud rates, the screen can scroll before you get a chance to read everything.    The 
Scroll Back facility stores a specified number of pages in the Scroll Buffer so that you can look at the data 
even after it has scrolled past.

- Select the Scroll Back option from the Edit menu or click the Scroll Back button.
- A tick appears next to the Scroll Back option.
- A scroll bar appears at the right of your emulation window.
- Scroll up to see previous pages.

To resume your communication session:
- Deselect the Scroll Back option from the Edit menu or click the Scroll Back button.
- Continue with your session.



How To ... 
Define a Device

Add a Device
Change the Settings for a Device
Set the Default Device
Remove a Device
Copy a Device



How To ... 
Configure a Terminal

Add a Terminal
Change the Settings for a Terminal
Set the Default Terminal
Remove a Terminal
Copy a Terminal



How To ... 
Configure a Protocol

Add a Protocol
Change the Settings for a Protocol
Set the Default Protocol
Remove a Protocol
Copy a Protocol



How To ... 
Establish a Connection

You can dial by using any of the following four methods: Open Terminal, Manual Dial, Dialing Directory or 
the Hot Dial Window.    All these options are available from the Communicate menu and the toolbar:

Open Terminal
Manual Dial
Dial from the Dialing Directory
Hot Dial Window



How To ... 
Add a Device

- Select the Device option from the Configure menu or click the Device Configuration button from the 
Configuration toolbar.
- Click the Add button.    The Modem Device Settings dialog box will appear on the screen.
- If you have a fairly common modem, click on the Vendor button.
- Select your modem type from the list that is presented to you.
- Click on the OK button.
- The settings applicable to your modem are automatically put into the Modem Device Settings dialog 
box.
- Click on the OK button.
- If you know your modem settings OR
- Your modem is not a commonly used one and doesnt appear on the vendor list, you can specify the 
settings yourself.
- Device Settings
- Click the OK button when you are done.
- Click the Close button.



How To ... 
Change the Settings for a Device

- Select the Device option from the Configure menu or click the Device Configuration button on the 
Configuration toolbar.
- Select the Device you want to change the settings for.
- Click the Edit button.    The Modem Device Settings dialog box will appear on the screen.
- Modify the settings you would like to.
- Device Settings
- Click the OK button when you are finished.
- Click the Close button.



How To ... 
Set the Default Device

- Select the Device option from the Configure menu or click the Device Configuration button on the 
Configuration toolbar.
- Choose the device you want as the default.
- Click the Default button.
- The name of the device you set as the default will appear at the bottom of the dialog box under Default.
- Click the Close button.



How To ... 
Remove a Device

- This action is irreversible so dont be in a hurry!
- Select the Device option from the Configure menu or click the Device Configuration button on the 
Configuration toolbar.
- Select the device you want to remove from the list.
- Click on the Remove button.
- Click the Close button.



How To ... 
Copy a Device

- Select the Device option from the Configure menu or click the Device Configuration button on the 
Configuration toolbar.
- Select the device you want to copy/duplicate from the list.
- Click the Duplicate button.
- Click the Edit button to modify the settings.
- Modify the desired Device Settings



How To ... 
Add a Terminal

- Select the Terminal option from the Configure menu or click the Terminal Configuration button on the 
Configuration toolbar.
- Click the Add button.
- Type the Name of the Terminal.
- Select the type of Terminal it is from the drop-down box.
- Click the Setup button.
- Modify the necessary Terminal Settings.
- Terminal Settings
- Click the OK button when you are done.
- Click the Keymapping button.
- Map the desired keys.



How To ... 
Change the Settings for a Terminal

- Select the Terminal option from the Configure menu or click the Terminal Configuration button on the 
Configuration toolbar.
- Select the Terminal for which you would like to change the settings.
- Click the Edit button.
- You can modify the Name and Type if necessary.
- Click the Setup button to modify the settings.
- Click the Keymapping button to add and change function key assignments and key mappings.
- Click the Close button when you are finished.



How To ... 
Set the Default Terminal Emulation

- Select the Terminal option from the Configure menu or click the Terminal Configuration button on the 
Configuration toolbar.
- Select the Terminal Emulation you would like to set as the default from the list.
- Click the Default button.
- The Terminal Emulation you selected will appear under Default at the bottom of the dialog box.
- Click the Close button.



How To ... 
Remove a Terminal

- By removing a Terminal you delete it together with all its settings.
- This action is irreversible so dont be in a hurry!
- Select the Terminal option from the Configure menu or click the Terminal Configuration button on the 
Configuration toolbar.
- Select the Terminal that you would like to remove from the list.
- Click the Remove button.
- The Terminal disappears from the list.
- Click the Close button.



How To ... 
Copy a Terminal

- Select the Terminal option from the Configure menu or click the Terminal Configuration button on the 
Configuration toolbar.
- Select the Terminal you would like to copy from the list.
- Click the Duplicate button.
- You can now customise the duplicate Terminal by changing the Settings.
- Terminal Settings



How To ... 
Add a Protocol

- Select the Protocol option from the Configure menu or click the Protocol Configuration button on the 
Configuration toolbar.
- Click the Add button.
- Type the Name of the new Protocol.
- Select the base-type of the protocol from the drop-down box.
- Click the Setup button.
- You can specify the protocol settings if your base-type is TTY, ZModem or Kermit.
- Protocol Settings
- Click the Close button.



How To ... 
Edit Protocol Settings

- Select the Protocol option from the Configure menu or click the Protocol Configuration button on the 
Configuration toolbar.
- Select the Protocol for which you would like to change the settings.
- Click the Edit button.
- You can modify the Name and Type if necessary.
- Click the Setup button to modify the settings.
- You can only modify the settings for the TTY, Zmodem and Kermit protocols.
- Protocol Settings
- Click the Close button when you are finished.



How To ... 
Set the Default Protocol

- Select the Protocol option from the Configure menu or click the Protocol Configuration button on the 
Configuration toolbar.
- Select the Protocol you would like to set as the default from the list.
- Click the Default button.
- The Protocol you selected will appear under Default at the bottom of the dialog box.



How To ... 
Remove a Protocol

- By removing a Protocol you delete it together with all its settings.
- This action is irreversible so dont be in a hurry!
- Select the Protocol option from the Configure menu or click the Protocol Configuration button on the 
Configuration toolbar.
- Select the Protocol that you would like to remove from the list.
- Click the Remove button.
- The Protocol disappears from the list.
- Click the Close button.



How To ... 
Copy a Protocol

This is a useful feature if you want to customise a base-protocol.
- Select the Protocol option from the Configure menu or click the Protocol Configuration button on the 
Configuration toolbar.
- Select the Protocol you would like to copy from the list.
- Click the Duplicate button.
- You can now customise the duplicate Protocol by changing the Settings.
- Protocol Settings



How To ... 
Hot Dial

- Select Hot Dial Window from the Communicate menu or click the Hot Dial Window button.
- A window containing all the dialing directory entries you have specified to be included in the Hot Dial 
Window in the Advanced Dialing Directory settings will be presented to you.
- Double-click on the icon of the entry you would like to dial.
- You may want to change the settings associated with that dialing directory entry e.g. the terminal 
emulation by Editing the Dialing Directory Entry.



How To ... 
Manual Dial

- Select Manual Dial from the Communicate menu or click the Manual Dial button.
- Select the device (modem) that you would like to use for the connection from the Device list.
- If you want to use a device that is not in the list, you must Define the Device.
- Select an Emulation from the Terminal list.
- You would choose an emulation that is supported by the host but you will know that you have the wrong 
emulation if the screen does not appear as you expect e.g. strange characters, mangled graphics etc.
- You can Customise an Emulation based on one of the standard emulations if you so desire.
- Enter the telephone number for the remote system.    You can also select the number from the drop-
down box if it is one of the last ten numbers you have dialed.



How To ... 
Upload a File

- Dial the host.

- Initiate the upload on the host.

- Select the Upload option from the File menu or click the Upload button.

- Select the file you would like to upload.

- Select the Path the upload file is in.    The path defaults to the one you have specified in the Preferences
dialog box.

- Select the Protocol you would like for your upload procedure.    YModem and ZModem protocols support
multiple file uploads i.e. you can specify more than one file to be uploaded at once.

- To choose multiple files for uploading, select the file you want to upload from the file section and click 
the Select button at the bottom of the dialog box.

- Repeat the above step for every file you want to upload.

- Select the appropriate file transfer protocol.

- An Upload Status dialog box appears to show you the progress of the upload procedure.



How To ... 
Download a File

- Dial the host.

- Initiate the download on the host.

- Select the Download option from the File menu or click the Download button.

- Select the file you want to download.    If you have selected YModem or ZModem protocols, the file 
names will be disabled as these protocols have an Autodetect facility.

- Select the Path for the file you want to download.    The path defaults to the directory you have selected 
in the Preferences dialog box.

- Select the appropriate    file transfer protocol.

- A Download status dialog box will appear showing you how far the download has progressed.



How To ... 
View Multiple Terminal Emulations

- Establish a connection with your host.

- Select Open Terminal from the Communicate menu or click the Open Terminal button.

- Make sure that your current device/modem is selected in the Device list.

- Select the terminal you would like to emulate from the Terminal list.

- Another terminal window will open up which will be emulating the same data stream as your first 
window but in the terminal emulation you just specified.

- You can decide which emulation you prefer and close down the window of the emulation(s) that you 
don't want.



How To ... 
Record Your Session

Recording your session is useful so that you can refer to the online system's options, etc. after your 
session has ended at your leisure without worrying about how much it is costing you to be connected to 
the online system.    Recording is achieved by means of a Capture file.    There are two ways in which you 
can get the Capture file to store your session.

Start Capture:
-   Establish a connection   with the host of your choice.

- Select Start Capture from the File menu or click the Capture button when you want to start recording.

- Select End Capture from the File menu or click the Capture button when you want to stop the recording.

- Another terminal window will open up which will be emulating the same data stream as your first 
window but in the terminal emulation you just specified.

- You can decide which emulation you prefer and close down the window of the emulation(s) that you 
don't want.

Save Scrollback:
-   Establish a connection   with the host of your choice.

- Select Save Scrollback from the File menu or click the Save Scrollback button.    This ensures that 
whatever is in your scrollback buffer at any time is also recorded in the capture file.

- You may want to adjust the size of the scrollback buffer in the Preferences option which can be selected
from the Configure menu.

- It is possible to automatically start capturing a session, i.e. capture without selecting Start Capture, if 
you are using the Dialing Directory to establish the communication session connection.

- Enable the Auto File Capture Start on Connect checkbox in the Advanced section of the Dialing 
Directory Entry settings.    This ensures that recording starts the moment you connect to the host specified
in that directory entry.



How To ...
Select Modem Vendor Default Settings

- .Select Device from the Configure menu or click the Configure Device button from the Configuration 
toolbar.

- Click the Vendor button.    You are presented with a dialog box containing the Vendor names and the 
models of the most commonly used modems.

- Find the Vendor of your modem in the list.    The Vendor names are written in bold.

- Select the model of your modem from the list under the Vendor name.

- Double click the modem model in the list or select it and click the OK button.

- You will be presented with the Vendor Settings Message dialog asking whether you want to change the 
name of the selected device or not.

- Click the Yes button if you want the name to be changed to the Vendor name and model in addition to 
the modem command strings.

- Click the No button if you want the modem command strings to change to the default strings for the 
model and Vendor selected but if you want the name to remain the same.

- .If you change your mind and don't want to change the modem command strings, click the Yes or No 
button and then click the Reset button in the Modem Device Settings dialog box.

- .Click the OK button in the Modem Device Settings dialog box when you are done.



How To ...
Edit Modem Command Strings

- There are two ways in which to set the Modem Command Strings: editing them manually or by selecting
the Modem Vendor.

- Select the Modem Vendor Default Settings OR

- Select Device from the Configuration menu or click the Device Configuration button..

- Select the device for which you want to edit the Modem Command Strings.

- Click the Edit button in the Device Configuration dialog box.

- .Click the Strings button in the Modem Device Settings dialog box.    You are presented with the Modem 
Command Strings dialog box.

- .Edit the Modem Command String Settings you would like to.



How To ...
Open Command Line Terminal

- Select Open Terminal from the Communicate menu or click the Open Terminal button.
- Select the device (modem) that you would like to use for the connection from the Device list.
- If you want to use a device that is not in the list, you must Define the Device.
- Select an Emulation from the Terminal list.
- Connecting in this method allows you to communicate directly with your modem through the terminal 
command line by using the Modem Command Set
- You can Customise an Emulation based on one of the standard emulations if you so desire.



How To ...
Select a Directory

- Select the directory by double-clicking on the appropriate directory name in the Directories list.    The 
path will be displayed under Directories.
- The files in the directory will be displayed according to the File Type that has been specified.    Select 
the appropriate file type you would like to view from the File Type list.
- All the files in the current directory of the specified file type will be displayed in the File Name list.
- Either select the appropriate file from the list or type the name of the file in the File Name box.    If the 
file is not in the current directory, type the path in front of the file name.
- .If you would like to select a directory on a network drive or on a shared directory on someone else's 
networked machine, click the Network button and select the desired directory.
- Click the OK button when you have selected the directory.



How To ... 
Record a Macro

- Establish a connection with your desired host.
- Select the Record Macro option from the File Menu or click the Record Macro button.
- You are presented with the Select Macro File Dialog box.
- Select the appropriate directory.
- Select a current macro file to record over OR type a new file name for a new macro file.
- Click the OK button.
- Perform the actions you would like to record.
- Select the Stop Macro Record option from the File Menu or click the Record Macro button to
stop recording.
- You can now Playback the Macro.



How To... Playback a Macro

You can playback a macro that you have recorded by calling it up manually at any time during a
communication session or can set it to be executed as soon as a connection has been established
with a particular host.

Manual Playback:
- Establish a connection with your desired host.
- Select the Playback Macro option from the File Menu or click the Playback Macro button.
- You are presented with the Select Macro File Dialog box.
- Select the appropriate directory
- Select a current macro file to execute.
- Click the OK button.
- The Macro Playback message box is presented to you.
- You can play, pause, resume or rewind the macro.
- Select the speed at which you would like the macro to execute by setting the speed scrollbar.

Startup Playback:
- This function can only be enabled for a dialing directory entry.    So, if the number for which you would 
like a macro to execute automatically is not in the the Dialing Directory you will have to add an entry in the
Dialing Directory for it.
- Open the Dialing Directory by selecting Dialing Directory from the Communicate menu or by clicking the
Dialing Directory button.
- Select the appropriate entry.
- Click the Edit Entry button, select Edit from the Dialing Directory menu or press the space bar to edit the
settings.
- Click the Directory button on the upper right side of the Directory Entry Details dialog box.
- Click the Macro radio button under the On Startup section of the dialog box.
- Make sure that the Macros default path is the one that your macro file is in.    If not, change the path so 
that it is correct.
- Type the name of the macro file without the file extension in the field next to the Macro radio button.
- Click the OK button.





Settings

Device Settings
Protocol Settings
Terminal Settings
Preferences
Dialing Directory Settings



Protocol Settings

ASCII Transfer Settings
ZModem Settings
Kermit Settings



Terminal Settings

ASCII Settings
ANSI Settings
AVATAR Settings
PRESTEL Settings
RipScrip Settings



Device Settings

HotKey Field
Alt-N Name
Alt-B Baud Rate
Alt-A Parity
Alt-W Word Length
Alt-7/8 Stop Bits
Alt-P Port
Alt-X/C/D Handshaking
Alt-R RX Buffer
Alt-T TX Buffer
(None) Dialing Delays
Alt-V Vendor
Alt-S Strings
Alt-L Direct Serial Link



Modem Command Strings

HotKey Field
Alt-I Initialization
Alt-P Dial Prefix
Alt-S Dial Suffix
Alt-O Answer On
Alt-F Answer Off
Alt-A Hangup
Alt-E Reset
Alt-C Connect String
Alt-1/2/3/4/5 No Connect 1 - 5



Kermit Settings

HotKey Field
Alt-M Max Packet Length
Alt-P Pad Count
Alt-C Pad Character
Alt-E EOL Character
Alt-Q Control Quote Character
Alt-R Repeat Prefix Character



ZModem Settings

HotKey Field
Alt-1 Use 16 bit CRC
Alt-3 Use 32 bit CRC
Alt-R Crash   Recovery  
Alt-A Auto Detect



ASCII Transfer Settings

HotKey Field
Alt-T Timeout
Alt-I Interline Delay

Upload:
Alt-U Strip LF
Alt-U Strip CR
Alt-U Add CR before LF
Alt-U Add LF before CR

Download:
Alt-D Strip LF
Alt-D Strip CR
Alt-D Add CR before LF
Alt-D Add LF before CR



Preferences

General Settings:
HotKey Field
Alt-C Cut & Paste: Translate Text
Alt-C Cut & Paste: Append CR
Alt-T Terminal Open Size
Alt-A Application Open Size
Alt-S Scroll Back Buffer
Alt-M Modem: Hangup on Port Close
Alt-M Modem: Confirm Modem Initialisation
Alt-M Modem: Confirm Modem Hangup
Alt-M Modem: Confirm Session Resume
Alt-O Tooltips: Display   Toolbar Tips  
Alt-O Tooltips: Display   Delay  
Alt-D Text Editor
Alt-P Strip High-Bit during Capture

Directory Settings:
HotKey Field
(None) Scripts
(None) Macros
Alt-C Capture
Alt-D Downloads
Alt-U Uploads
Alt-F File Receive: Check Disk Space
Alt-F File Receive: Delete Partial Files
Alt-P Port Sharing
Alt-D Directory: Automatic Redial
Alt-D Directory: Directory Toolbar
Alt-M Minimize on Dial: Hot Dial Window
Alt-M Minimize on Dial: Dialing Directory



RipScrip Settings

HotKey Field
Alt-H Button Hotkeys
Alt-F Field Tabbing
Alt-P Protected Mode
Alt-B Destructive Bksp
Alt-D Destructive Tabs
Alt-M ANSI Music
Alt-C Column Wrap
Alt-V VT100 Wrap
Alt-A Fast Output
Alt-I Icons Subdirectory
Alt-O/G Fast Mark



ANSI Settings

HotKey Field
Alt-S Font Size
Alt-L Lines
Alt-C Columns
Alt-B Destructive Bksp
Alt-D Destructive Tabs
Alt-A ANSI Music
Alt-W Column Wrap
Alt-V VT100 Wrap
Alt-F Colour Flashing
Alt-O/T/G Fast Mark



ASCII Settings

HotKey Field
Alt-S Font Size
Alt-L Lines
Alt-C Columns
Alt-B Destructive Bksp
Alt-D Destructive Tabs
Alt-W Column Wrap
Alt-O/T/G Fast Mark



AVATAR Settings

HotKey Field
Alt-S Font Size
Alt-F ANSI Fallback
Alt-L Lines
Alt-C Columns
Alt-O/T/G Fast Mark



Prestel Settings

HotKey Field
Alt-O/T/G Fast Mark



Dialing Directory Settings

Normal
HotKey Field
Alt-M Name
Alt-N Numbers
Alt-L Login Name
Alt-P Password
Alt-T Terminal
Alt-D Device
Alt-P Protocol

Advanced
HotKey Field
Alt-N System Comments and Notes
Alt-S Scripts
Alt-M Macros
Alt-C Capture
Alt-D Downloads
Alt-U Uploads
Alt-A Auto File Capture
Alt-I Include in Hot Dial Window
(None) On Startup





Font Size
This setting allows you to select the height X width size of the font.    You can choose between 8 X 9, 14 X
7, 16 X 8 or    18 X 9.

VGA (400x600) Default Setting: 14 X 7
SVGA (600x800) Default Setting: 16 X 8



Lines
Specifies the number of lines on your screen when the Terminal Emulation is open.

TTY Default Setting: 25
ANSI & Avatar Default Setting:24



Columns
Specifies the number of columns on your screen when the Terminal Emulation window is open.    The 
default for all the Terminal Emulations this setting applies to is 80.

Default Setting: 80



Destructive Tabs
You can specify whether the tab key deletes the next 8 characters or just jumps forward 8 characters.

Default Setting: OFF



Column Wrap
This setting determines whether the text will wrap onto the next line when you reach the last column 
(Column 80) on the screen.

Default Setting: ON



Fast Mark
This setting is related to the Mark Graphics and Text option in the Edit Menu.    If the setting is on Off, any 
mouse action will have no effect.    If the setting is on Text the mouse operation will mark text.    If the 
setting is on Graphics the mouse operation will have the effect of marking Graphics.    The default setting 
is on Text for all Terminal Emulations except RipScrip.    The RipScrip Emulation default is Graphics as 
there is no Mark Text option for it.

RipScrip & Prestel Default Setting: OFF
All other Terminals Default Setting: TEXT



Destructive Bksp
You can choose whether you would like the character on the left of the cursor to be deleted if you send a 
backspace key.

Default Setting: ON



ANSI Music
This setting allows you to enable or disable playing the music the terminal receives.

ANSI Default Setting: ON
RipScrip Default Setting: OFF



VT100 Wrap
Enabling this setting will allow you to type a character at the very bottom right-hand corner of the screen 
without the whole screen scrolling.

Default Setting: ON



Colour Flashing
Enables or disables the flashing of colour text.

Default Setting: ON



ANSI Fallback
This setting is only available in the Avatar Emulation.    If the setting is enabled and ANSI sequences come
throgh on the Avatar terminal, it will execute the ANSI characters.    If the setting is disabled, the ANSI 
characters will be treated as normal characters.

Default Setting: ON



Protected Mode
If Protected Mode is enabled, any data that you have entered e.g. your name and age, cannot be queried 
from your terminal by any BBS without your approval.    You can preview any user text variable question to
decide if you realy want to send the information to the host.    You can also edit the text variable (i.e.blank 
or garble) before sending it to the host so that you are in control at all times of the information that the 
host gets about you.

Default Setting: OFF



Icons Subdirectory
The name of the directory where all the Icons are kept.    This setting is available only for the RipScrip 
terminal as no other terminals support icons/graphics.

Default Setting: ICONS



Fast Output
Enabling this setting allows graphics to be displayed faster provided you have 256 colour drivers installed.
The 256 colour drivers can, however, cause problems with the other drivers installed on your machine so 
you may have to disable the Fast Output setting.

Default Setting: ON



Button Hotkeys
A RipScrip setting.    Enables or disables any hotkeys defined in RipScrip.

Default Setting: ON



Field Tabbing
Enables or disables tabbing to RipScrip buttons.    If you are not using a mouse, Field Tabbing should be 
enabled.

Default Setting: ON



Translate Text
If the Translate Text setting is ENABLED, any text that has been copied that is not part of the standard 
WIndows character set will be as closely subsituted as possibl

Default Setting: OFF



Append CR
Automatically appends a Carriage Return at the end of each line of text instead of pasting it as continuous
text.

Default Setting: ON



Hangup on Port Close
When enabled, closing a Terminal Emulation window will automatically hang up the call. You would not 
want to enable this setting if you want to switch to another Communications Package immediately after 
using WinRamp.

Default Setting: ON



Confirm Modem Initialisation
Determines whether your modem will be re-initialised when you a start a Terminal Emulation.

Default Setting: ON



Toolbar Tips
Determines whether the Toolbar Tips are presented to you when you keep your mouse cursor on any of 
the toolbar tools.

Default Setting: ON



Delay
You can specify how long, in milliseconds you would like the Toolbar Tips to take to appear on the screen. 
The limit is 9999

Default Setting: 1250ms



Scroll Back Buffer
Determines how many lines you would like the scroll back buffer to store.    The limit is 999 lines.

Default Setting: 300



Downloads
Allows the specification of the default download directory.

Default Setting: ON



Uploads
Allows you to specify the default upload directory.

Default Setting: ON



Timeout
Specifies how long,in seconds, to wait for the first character, before aborting the transfer.

Default Setting: 60



Interline Delay
The period of time, in milliseconds, to wait between the sending of each line, for the remote system to be 
ready to receive another line.

Default Setting: 0



Strip LF
Removes the Line Feed character from the transfer stream.

Default Setting: OFF



Strip CR
Removes the Carriage Return character from the data stream.

Default Setting: OFF



Add CR before LF
Add a Carriage Return character before every Line Feed character found in the data stream.

Default Setting: OFF



Add LF after CR
Add a Line Feed character after every Carriage Return character found in the data stream.

Default Setting: OFF



Use 16 bit CRC
The ZModem standard allows for the use of 2 octet or 4 octet error-correction codes. Select whichever is 
used by the remote system.

Default Setting: OFF



Use 32 bit CRC
The ZModem standard allows for the use of 2 octet or 4 octet error-correction codes. Select whichever is 
used by the remote system.

Default Setting: ON



Recovery
ZModem allows for partially received file transfers to continue from where they stopped. Check this option
if you wish to make use of this feature.

Default Setting: OFF



Auto Detect
Determines whether the ZModem downloads will start automatically when the remote system starts 
sending? You should only disable this option if you experience numerous false starts of a download.

Default Setting: ON



Max Packet Length
The maximum number of bytes that will be sent per block of data. Newer Kermit implementations may 
support larger blocks, but there is no automated way of finding out if this is possible.

Default Setting: 94



Pad Count
Determines how long to delay inbetween packets of data.

Default Setting: 0



EOL Character
Allows you to determine which character to use to signify the end of a line.

Default Setting: 13



Control Quote Character
Determines which character to "quote" in the data stream.This character is generally known to cause 
problems if sent on the data stream, so alternate methods are employed to transfer data containing this 
character.

Default Setting: 35



Repeat Prefix Character
Signifies that a data character is repeated in the data stream.

Default Setting: 126



Pad Character
Specifies which character to send on the data stream while time is being wasted between packets

Default Setting: 0



Name
Add:    Type in the name of the Device you would like to add.
Edit:    Displays the current name of the Device you have selected.    You can type a new name if you 
would like to change the current name.



Baud Rate
Consult your Modem Manual and change the setting if necessary.    It is best to select the highest Baud 
Rate your Modem can handle.    The default is 19200.

Default Setting: ON



Parity
The default setting is none but you may need to change it especially if you have an old Modem.    Consult 
your Modem manual for the appropriate setting.

Default Setting: NONE



Word Length
This setting relates to the number of bits a byte contains.    In most cases the default of 8 is fine, but some
machines use 7 bits.    CompuServe requires 7 bits.

Default Setting: 8



Stop Bits
The default is 1 but you may need to change it depending on your Modem.    Your Modem manual will 
have the details of the suitable setting.

Default Setting: 1



Port
Check which port at the back of your machine, your communications equipment (Modem) is plugged into. 
If the ports are not labelled on your machine, you can consult your Hardware Manual.



Handshaking
Handshaking is used for Flow Control. If your Modem and your Computer do not transmit at the same 
speed, handshaking signals the computer to slow down.    If you are not sure which protocol your modem 
supports, you can select both the XON/XOFF and the CTS/RTS protocols.

XON/XOFF is a software flow control using sppecial chasracters and is used if you have a 3-wire 
connection.
Default Setting: ON

The CTS/RTS handshake protocol is a hardware flow control and requires a 7-wire cable instead of a 3-
wire cable.    It uses 2 out of these 7 wires for the actual flow control.
Default Setting: ON

DSR/DTR is also hardware flow control but is an older standard than the CTS/RTS.    This protocol also 
requires a 7-wire cable but uses different cables for the actual handshake than the CTS/RTS protocol.
Default Setting: OFF



RX Buffer
The size of the Receive Buffer can be increased if you find that characters are being lost.    The default 
setting, will, however, be sufficient in most cases.

Default Setting: 5120



TX Buffer
The default Transmit Buffer setting is adequate in most cases, but you can change the size if you find you
are losing characters.

Default Setting: 5120



Dialing Delays
During:    the amount of time, in seconds, WinRamp will wait for the modem on the other side to respond 
to its connect string.
Default Setting: 60

Retries:    the number of times WinRamp Lite will retry the number it has failed to connect to.    
Default Setting: 5

Retry Delay:    the amount of time, in seconds, WinRamp Lite will wait after a connection has failed, to 
retry the number.
Default Setting: 5



Dial Prefix
The Dial Prefix makes the modem dial a telephone number and specify whether it is a tone or pulse 
dialing exchange.

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



Answer On
This is the command to switch the auto-answer on.    The auto-answer mechanism enables the modem to 
answer the phone that it is connected if it rings.

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



Hangup
The command that gets the modem to disconnect the line.

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



Dial Suffix
These are the characters that will be sent after the telephone number in order to initiate the dialing

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



Answer Off
This is the command that is used to turn the auto-answer mechanism off.

Default Setting: ON



Connect String
The Connect string signals connection to the host modem.

Default Setting: CONNECT



Initialization
The initialization string resets the modem internally in order to communicate in a certain way.    When you 
select the name of the vendor, the default settings are automatically put in, you can, however, change 
them if your modem manual specifies a different set of settings.

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



No Connect 1 - 5
These are the different reasons for a failed connection.    Check your modem manual to see the 
functionality supported by your modem.

Default Settings: No Connect 1: NO CARRIER
No Connect 2: BUSY
No Connect 3: NO ANSWER
No Connect 4: NO DIALTONE
No Connect 5: VOICE



Name
The name of the computer/BBS you would like to communicate with.



Numbers
You can add an unlimited number of numbers that can dial to the machine you want.    WinRamp will dial 
the first one and if it cant get through, it will try the next one and so on until it gets through.



Login Name
The login name required (if any) by the computer you would like to connect to can be typed in here.    If 
you want to type it in when you connect or if there is no login name required, simply leave the setting 
blank.



Password
The login password that the computer you are connecting to requires (if any).    If you would like to type it 
in at the time of connection or if no password is required, you can just keep this setting blank.



Comment
This is a text entry field that you can use to put any additional information about the machine the number 
will connect you to.    This field is not a setting and will not affect the Dialing process in any way.



Terminal
You can specify the terminal emulation your computer will create from this list.    The one you choose 
depends on the emulations that the computer you want to connect to supports.

Default Setting: The Terminal set as the Default Terminal in the Terminal Configuration dialog box.



Device
Choose the type of modem that you would like to use to communicate with the other machine.

Default Setting: The Device set as the Default Device in the Device Configuration dialog box.



Protocol
You can set the protocol your machine will use to communicate with the other machine.    The one you 
choose should be the one that the other computer (the host) supports.

Default Setting: The Protocol set as the Protocol Terminal in the Protocol Configuration dialog 
box.



Connect Information 
This section of the dialog box provides useful information about the last time you established a 
connection with that particular BBS/host.    The following is part of the Connect Information: the date, time 
and length (in minutes) of your last connection, the total number of connects you have had, the number 
and size (in kilobytes) of files you have downloaded and uploaded as well as the ratio of downloads to 
uploads.

Default Setting: ON



Capture Directory
The default directory for the capture file to be kept.

Default Setting: The directory specified in the Preferences dialog box.



Download Directory
The default directory to which all the files to be dowloaded will be written.

Default Setting: The directory specified in the Preferences dialog box.



Upload Directory
The default directory on your computer where any files that you may want to upload are stored.

Default Setting: The directory specified in the Preferences dialog box.



Auto File Capture
Enabling this setting means that your communication session will be recorded automatically from the 
moment you connect to the BBS/host i.e. you will not have to go and select Start Capture from the File 
menu.    The session will be recorded in the capture file until you decide to stop capturing by selewcting 
End Capture from the File menu.    

Default Setting: ON



Include in Hot Dial
You can choose to include the current dialing directory entry in the Hot Dial window.    The Hot Dial 
window is designed for the BBS's/hosts that you most frequently connect to so that it is easier to dial 
them.

Default Setting: ON



Application Open Size
Determines whether WinRamp Lite will open up to the size you had it when you exited it last (Save on 
Exit) or to its Maximised size when it starts up again.

Default Setting: SAVE ON EXIT



Hangup on Port Close
Enabling this setting results in the modem hanging up if the terminal emulation window is closed.

Default Setting: ON



Confirm Modem Hangup
Determines whether you are asked to confirm the action of hanging up the modem before WinRamp Lite 
does it.

Default Setting: ON



Confirm Session Resume
Determines whether you are asked to confirm whether you want to resume a session or not.    Resuming 
a session means that your modem will not be reset and you can continue using it.

Default Setting: ON



Text Editor
The Text Editor application you would like to launch when you select Tex Editor from the File menu.

Default Setting: notepad.exe



Strip High Bit during Capture
Enabling this setting takes the incoming data stream and converts it to ASCII characters by stripping off 
the most significant bit in the characters.

Default Setting: ON



Check Disk Space
Checks disk space before beginning a download procedure.    If the file is too large you will be warned 
before the transfer takes place if the setting is on.

Default Setting: ON



Delete Partial Files
Deletes any files that might have been only partially dowloaded due to an error or if you pressed Cancel 
during the download procedure.

Default Setting: ON



Hot Dial Window
Determines whether the Hot Dial window will be minimised once you begin the dial procedure.

Default Setting: ON



Dialing Directory
Enabling this setting causes the Dialing Directory window to be minimised once you have begun the dial 
procedure.

Default Setting: ON



Port Sharing
This setting is very important if you want to view the same incoming data stream in more than one 
terminal emulation.    You can choose to Disallow port sharing i.e. you will not be able to open more than 
one terminal emulation, you can choose to Automatically share the port when you open another window 
or you can ask WinRamp Lite to Prompt you i.e. you will be asked whether you want to share the port or 
disallow sharing evry time you want to open another terminal window.

Default Setting: AUTOMATIC



Capture
Determines the default directory for the capture file.

Default Setting: ON



Terminal Open Size
Determines what the size of the terminal emulation window will be when it opens up.    It can either be set 
to open to the default or the maximised size.

Default Setting: DEFAULT



Vendor
Brings up the Modem Vendor Defaults dialog box containing a list of vendor names and models of the 
most commonly used modems.    The default strings for each type of modem will be automatically updated
in the Modem Command Strings settings when you select your modem type from this dialog box.



Reset
The command that gets the modem to reset.

Default Setting: Depends on the Modem type chosen in the Vendor dialog box.



Directory Toolbar
Determines whether the Dialing Directory toolbar appears on the screen when Dialing Directory is 
selected from the Communicate menu or when the Dialing Directory button is clicked on.

Default Setting: OFF



Automatic Redial
This setting is applicable only to Dialing Directroy entries.    It determines whether WinRamp Lite 
automatically starts dialing the first number again on the list of numbers for the selected Dialing Directory 
Entry once it has not been able to connect to any of them.

Default Setting: OFF



Script Directory
Allows you to specify the default directory for any scripts you may have written.    Although there is no 
Script support in WinRamp Lite, a full-featured Script Language will be available in a later version.



Macro Directory
Determines the default directory for any Macros that you may have written for automation purposes.



Direct Serial Link
Disables all the modem commands so as to enable a serial link with the host.

Default Setting: OFF



On Startup
Allows you to specify whether or not a macro of your choice will automatically be executed when a 
connection to the host pertaining to a particular directory entry is established.    Later versions of 
WinRamp Lite will allow you to startup the connection with a script.

Default Setting: NOTHING 









Trouble Shooting, Errors and Warnings

Warning & Error Messages

1. Overwrite Capture File
2. Capture File Exists
3. RIPScrip Emulation
4. Port Open
5. Port Open Error
6. Capture File Closed
7. Out of System Memory
8. No Numbers to Dial
9. Filename Exists
10. Invalid Directory Name
11. Delete Entry?
12. Delete Entries?
13. New Directory?
14. Create Directory Error
15. No Devices
16. No Terminals
17. No Protocols
18. No Icons
19. Invalid Filename
20. Invalid Value
21. Vendor Settings
22. Missing Suffix
23. Disk Space Low
24. Cancel Dialing?
25. Restart Dial Queue
26. Filename Required
27. File Exists
28. Delete Directory?
29. Active Session Detected
30. No Toolbars to Delete
31. Select Toolbar
32. No Toolbar Defined
33. Delete Toolbar?
34. Unsupported Keyboard
35. Open New Key Mapping?
36. Overwrite Key Mapping?



Overwrite Capture File

Current contents will be lost. Continue?

The file name and directory you have chosen for the file capture has already been used. Click on OK to 
overwrite the existing file contents with the new file capture. If you want to replace the file on the disk with 
the one you are saving, choose the OK button. Click on Cancel to avoid overwritng the existing file and 
enter a new file name or path that has not already been used. If you want to preserve the file on the disk, 
choose the Cancel button and type a different filename. If the file name you have chosen is marked by the
operating system as a read-only file, you cannot overwrite it. Choose the Cancel button to cancel the 
command, and save the file with a different name.



Capture File Exists

This file already exists.    Capturing to it will erase its current contents.

The file name and directory you have chosen for the file capture has already been used. Click on OK to 
overwrite the existing file contents with the new file capture. If you want to replace the file on the disk with 
the one you are saving, choose the OK button. Click on Cancel to avoid overwritng the existing file and 
enter a new file name or path that has not already been used. If you want to preserve the file on the disk, 
choose the Cancel button and type a different filename. If the file name you have chosen is marked by the
operating system as a read-only file, you cannot overwrite it. Choose the Cancel button to cancel the 
command, and save the file with a different name.



RIPScrip Emulation

Your graphics driver currently supports only 16 colors.    RIPScrip colors may look incorrect. We 
recommend that you use a 256 color graphics driver. 

Do you wish to continue receiving this notification?

The original RIPScrip Graphical Terminal Emulation implementation was developed using the Borland 
BGI Graphics Drivers under EGA, and thus supported 64 colours. This has made support under MS-
Windows VGA (and lower) somewhat problematic in that the Windows VGA standard generally supports 
either 16 colours or a jump straight 256 colours.    
Under WinRamp Lite we have endeavoured to translate, as accurately as possible,    the 64 colour palette
for optimal use under 16 colour VGA mode, however we strongly recommend that you install the 
necessary Graphics Drivers for 256 colours. 

Please refer to your MS-Windows documentation for more information regarding the installation of 
additional Graphics Drivers, in addition to the documentation accompanying your computer system. 



Port Open

Would you like to share the port?"

WinRamp has the ability to show multiple views of an incoming stream of data.    If you already have one 
view open, the next view that you open will cause this prompt.    If you intended to have two views open, 
select Yes, otherwise select No and choose a different port.



Port Open Error

Port already open by another process

Although WinRamp can show two Windows on a data stream, this is only possible if WinRamp is the 
application using the port.    If you have another application, such as the Windows Terminal open, using a 
port, then Windows will not allow WinRamp to open that port.    To use the port with WinRamp, you must 
close the other application which is using the port.



Capture File Closed

Would you like to view the capture file?

Answer yes if you would like to review the data which was stored in the capture file.



Out of System Memory

Not enough memory to complete operation

There are too many applications open on your Windows Desktop.    Try closing some applications down 
before trying the operation again.    Consult your Windows manual if this error message persists.



No Numbers to Dial

This directory entry has no numbers defined

You have tried to dial with an entry in the Dialling Directory which has no telephone numbers defined.    
You need to edit the entry in the Dialling Directory and add at least one number in the list of numbers.



Filename Exists

File already exists, please choose another filename

The filename you have chosen to use already exists on your drive.    Either use file manager to delete the 
file and try again, or choose a different filename.



Invalid Directory Name

Enter a valid directory name

The directory which you have chosen to store files in does not exist, please choose a directory which 
already exists on your disk.



Delete Entry?

Are you sure you want to delete this entry?

Press Yes if you wish to delete the entry, otherwise press No.    If you are unsure, press No.



Delete Entries?

Are you sure you want to delete these entries?

Press Yes if you wish to delete the entries, otherwise press No.    If you are unsure, press No.



New Directory?

The directory does not exist.    Create it now?

The directory you have chosen to use does not currently exist, and will be created.    If you believe the 
directory should exist, you may have mistyped it.    Choose No if you want to re-specify the directory 
name, otherwise choose Yes.



Create Directory Error

Could not create directory

The directory could not be created, either because the disk is full, or you do not have permission to create
sub-directories from that directory.    Choose another path for the directory.



No Devices

No Communications Devices Defined

Before you can connect to a system, you must have defined a device.    To do this, choose Devices from 
the Configure menu and choose 'Add'.



No Terminals

No Terminal Emulations Defined

There are no Terminal Emulations available to WinRamp Lite.    This may be caused by some of the 
configuration files becoming corrupt.    You need to restore WinRamp Lite from a backup, or re-install the 
package.



No Protocols

No Transfer Protocols Defined

There are no Transfer Protocols available to WinRamp Lite.    This may be caused by some of the 
configuration files becoming corrupt.    You need to restore WinRamp Lite from a backup, or re-install the 
package.



No Icons

There are no icons associated with this file

The file you have chosen does not contain any icons which can be displayed.    Usually icons are only 
contained in files with the extensions : EXE, ICO, DLL.    This message may also come up if you change 
to a directory which contains no icon files.



Invalid Filename

A valid filename is required

For this dialog, you must enter a filename which exists.    Check that you did not mis-type the name of the 
file.



Invalid Value

RXBuffer: Value of 1 - 65535 expected

The buffer size you have entered is out of the allowable range.    You must enter a number greater than or 
equal to 1, and less than or equal to 65535.



Vendor Settings

Do you want to change the device name?

Select Yes if you want to change the device name. Select no if you chose this option by mistake and wish 
to leave the device name as it is.



Missing Suffix

The dial suffix has no ^M. Must one be appended?

Most modems require that the dialling command end with a Carriage Return.    This message is a 
confirmation to ensure that you did not accidentally omit the ^M in the Dial Suffix field.    If your modem 
specifically does not require a ^M, you should choose No. If you are unsure, choose Yes.



Disk Space Low

There is not enough disk space. Continue?

There may not be enough disk space remaining to be enable downloading a file, or for the reliable 
operation of WinRamp Lite.    You may still continue, but you may not be able to succesfully perform 
certain operations (such as downloading a file).    Try to make some disk space available at the earliest 
opportunity.



Cancel Dialing?

Cancel dialing process?

You have chosen to abort the dialling process.    Choose Yes if you wish WinRamp Lite to stop dialling.    
Choose No if you cancelled in error, and wish WinRamp Lite to continue dialling the selected systems.



Restart Dial Queue?

Do you want to start again?

WinRamp Lite has reached the end of the list of telephone numbers to try - pressing Yes will cause 
WinRamp Lite to begin dialling the numbers from the first number again.    Choosing No will stop the 
dialling process.    



Filename Required

A file name is required for this protocol

Before you can begin downloading a file with the currently selected protocol, you must specify a local 
filename for the file.    Generally you would name the file the same as the remote system names the file.    
Most protocols will automatically name the file, but some older transfer protocols do not have this ability.



File Exists

File already exists, delete?

Choose Yes if you want to delete the file specified, otherwise choose No.    If you are unsure, choose No.



Delete Directory?

Are you sure you want to delete the directory?

Choose Yes if you want to delete the directory specified, otherwise choose No.    If you are unsure, 
choose No.



Active Session Detected

Do you want to resume this session? No will hangup modem.

You are opening a session using a Device which indicates that it is already connected to a remote 
system.    You can resume the previous session by choosing yes, or create a new session by choosing 
No.    If you specifically wish to terminate the session using that device, choose Yes to hangup the device.



No Toolbars to Delete

There are no toolbars to delete

You have selected to delete a toolbar when no toolbars are defined.    



Select Toolbar

No toolbar selected

You must select a toolbar to perform this operation.    This message occurs with operations which apply to 
a specific toolbar only, requiring you to indicate the toolbar on which to perform the operation.



No Toolbar Defined

There is no toolbar defined!

An operation has been attempted which requires at least one toolbar to be present.    You should first 
create a toolbar and then retry the operation.



Delete Toolbar?

Are you sure you want to delete toolbar <toolbar name>

Please confirm that you wish to delete the toolbar.    Press No if you are unsure.



Unsupported Keyboard

This keyboard is not supported. Assuming IBM Enhanced keyboard.

The keyboard defined in Windows is not currently supported by WinRamp Lite.    WinRamp Lite will resort 
to the default keyboard mapping, which is the IBM enhanced keyboard. Key mappings are the definitions 
of which characters are sent to the remote system when you press each physical key on the keyboard.



Open New Key Mapping?

Current key mappings will be lost! Are you sure you want to create a new mapping?

Choosing Yes will delete the current key mappings which are in use, and create a new set. Key mappings 
are the definitions of which characters are sent to the remote system when you press each physical key 
on the keyboard. If you are unsure, choose No.



Overwrite Key Mapping?

This will replace the current mapping.    Go ahead anyway?

Continuing with this operation will delete the current key mapping to replace it with a new mapping.    This 
may cause the remote system to respond incorrectly.    Choose No if you did not intend to replace the key 
mapping.



Create Directory

The DOS directory <directory name> does not exist. Create it?

The directory name you have specified does not currently exist.    WinRamp Lite will create the directory 
for you if you choose Yes.    If you believe the directory does already exist, you may have mis-typed the 
name, or you may be using the wrong drive letter.    Choose No and re-type the name of the directory.



No Name

The new <Protocol/Terminal/Device> you have added has no name. Continue anyway?

You should specify a name to seperate this Device, Protocol or Terminal from others.    An item with no 
name may not be editable or modifiable later. You should choose No and go back and add a name.



No Dialing Entries 

The entries you have chosen are Direct Serial Link entries. Multiple entries are not supported 
within the Dialing Queue. The first Direct Serial Link entry selected will be used.

You cannot queue calls to multiple systems which are directly connected because these systems do not 
have a dialling facility.    Generally any directly connected system is always available, and will terminate 
the dialling process automatically.    WinRamp Lite will connect you to the first directly connected entry you
specified.    To avoid this message, do not add any directly connected systems to the dialling queue.



No Dial Entry

You have chosen a Direct Serial Link entry. It cannot be dialed and will be ignored.

You cannot dial a system which is directly connected. You will be automatically connected without any 
dialling process occuring.



No Dialing Number Entry

The entry you have chosen does not have a valid number. It will be ignored.

The telephone number you specified in a Dialling Directory entry contains characters which are not valid 
and cannot be dialled.    The telephone number will be ignored.



Critical Component Missing

Critical WinRamp Lite components cannot be found. This may have been caused by a failed 
installation, or an incomplete file set. Please refer to the Online Help and the WINRAMP.WRI file.

You may have to restore WinRamp Lite from a backup, or re-install the package.



Critical Component Gone Missing

Critical WinRamp Lite components cannot be found. This is most likely to have been caused by a 
deleted, renamed or moved .DLL file. Please refer to the Online Help and the WINRAMP.WRI file.

You may have to restore WinRamp Lite from a backup, or re-install the package.




